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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in April 2023

Sector Indices vs HSI / HSCEI

Index Name

HS Mainland
Banks Index

HSCEI -3.8%

Equity Index Futures Access Codes

+2.6%

% Change

CES120 vs China Theme Indices

Index Name

FTSE A50 Index -2.1%

CSI 300 Index -2.2%

CES120 Index -3.5%

MSCI China A 50 Connect Index -3.5%

% Change

Vendor HS Mainland Banks CES 120 HSI HSCEI
Bloomberg BMWA CESA HIA HCA
Refinitiv O0#HMBI: O0#HCHH: O#HSI: O#HCEL:
WIND MBIF CHHF HSIF HHIF
ET Net MBI CHH HSI HHI

Data Source: Bloomberg
As at 28 April 2023

Information for reference only
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Equity Index Futures & Options
Hang Seng Index (HSI) Futures & Options

E )G e

(2023 vs 2022)

Av erage Daily Volume Open Interest Av erage Daily Volume Open Interest
(No. of Contracts) (No. of Contracts) (No. of Contracts) (No. of Contracts)
0 0 280,000 - mmmmm ADV (L-Axis) - 200,000 60,000 - ADV (L-Axis) - 400,000
HSI Futures 143,928 (-6%) 131,290 (+15%) 240,000 - Open Interest (R-Axis) Open Interest (R-Axis)
200,000 - - 150,000 45,000 - - 300,000
160,000 -
o - 100,000 30,000 - - 200,000
Mini-HSI Futures 99,302 (-8%) 12,993 (+10%) 120,000 -
80,000 1 - 50,000 15,000 - - 100,000
40,000 -
0 - -0 0+t 0
HSI Options 24,620 (-5%) 122,190 (+13%) N 00 O N OO N
S S S S S S S S S S S
HSI Futures (MoM) HSI Options (MoM)
Mini-HSI Options 14,125 (+13%) 19,330 (+44%)
Av erage Daily Volume Open Interest Average Daily Volume Open Interest
(No. of Contracts) No. of Contracts
0 600 ADV (L-Axis) (No. o Soneees) 45,000 - ADV (L-Axis) ™ 566,000
Open Interest (R-Axis) Open Interest (R-Axis)
HSI Futures |
. 4,419 (+70% 60,675 (+15% 150,000 - - 150,000 - 150,000
Options (+70%) (+15%) D Vil 30,000 - \/\/\
100,000 - - 100,000 - 100,000
. 15,000 -
HSI VOlatlllty 0 (_) 0 (_) 50,000 - - 50,000 - 50,000
Index Futures
01 [ 0 0 > o= >0 0
o Sc=o0a= >0 [ csSso9ap cCQ TS5
HSI Dividend §5333858588<% £5333825888<3
Eo;nt Index 136 (+369%) 9,521 (+2866%) 022 5023 2029 | 5023
utures

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 28 April 2023
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level HSI & Top 5 Constituents

. Includes the largest and most ('000)
Index Description _ ’ . 24 36 120 -
liquid stocks listed in Hong Kong | e—HS|  —\HS| I e HS| Index — Tencent
Index Level 19,894.57 (As at 28 Apr 2023) HSBC —AIA
3 Meituan Baba

Index Volatility (30-Day Historical) | 29.9 29 | 100
Index Avg. Day High-Low Range 256.91 (Apr 2023) L o8
HSCE! Correlation (2023) 0.982 20 - 80 -

- 24
Hang Seng Index Futures 18 0 60

Feb-23  Mar-23  Apr23 Feb-23 Mar-23 Apr-23

Contract Multiplier HK$50

Notional Value (1 Contract) HK$0.99Mn (As at 28 Apr 2023) Distribution of HSI Index Options Ol in Month-end
Call Put
Transaction Cost* Agg.g
S 8292
Stamp Duty N/A S Z26.4
2—: o 24.4
Trading Fee HK$10 / contract g & 557
5 L2192
SFC Levy HK$0.54 / contract = & 18.2
o] w 17.2
. 3 o x () 16.2 k
Commission Rate Negotiable 2 B 152 —
£ — 142 =
. 13.2
Margin as of 24 Apr 2023 HK$76,650 122 L
100 —~—"——+—————
0 1 2 3 4 5 6 012 3 456 7 89
Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 28 April 2023
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Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Futures (YoY) HSCEI Options (YoY)
HSCEI Products or*

ADV
(2023 vs 2022) Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
240,000 - == ADV (L-AXis) - 700,000 120,000 + ADV (L-Axis) r 2,800,000
Open Interest (R-Axi Open Interest (R-AXis)
J - 600,000 i - 2,400,000
HSCEI Futures 195,628 (+7%) 595,646 (-2%) 200000 [ c00.000 100,000 [ 200,000
160,000 - ! 80,000 - ! !
- 400,000 - 1,600,000
120,000 - 60,000 -
- 300,000 - 1,200,000
Mini HSCEI 80,000 - 40,000 -
Fut SIS 10,836 (-20%) 3,688 (-27%) - 200,000 - 800,000
utures 40,000 - - 100,000 20,000 - - 400,000
0 - 0 0 L e e e e e e 0
N N D O A9 NS
. ) S S S S S S
HSCEI Options 50,123 (+11%) 1,274,092 (+11%) v
HSCEI Futures (MoM) HSCEI Options (MoM)

.. Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
Mln-l HSCEI 3,948 (+13%) 26,909 (-4%) (No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
Options 275,000 | s ADV (L-AxiS) - 700,000 80,000 - ADV (L-Axis) - 2,000,000

Openinterest(R-Axis) | Open Interest (R-AXis)
220,000 - 600,000
L 500,000 60,000 - - 1,500,000
HSCEI Futures n '
. 37,162 (+91%) 1,016,693 (+38%) 165,000 - . 400.000
SERE ' 40,000 - - 1,000,000
110,000 - - 300,000 ' o
.. - 200,000
HSCEI Dividend 55,000 - 20,000 - - 500,000
Point Index 1,391 (+2%) 88,271 (+54%) - 100,000
Futures 07 "0 0 0
>Scsoahn 2 oc =5
853375558888 ¢%
2022 2023

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 28 April 2023
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI

Comprises the largest and
Index Description pri d

most liquid H shares HSI HSCEI
Index Level 6,702.15 (As at 28 Apr 2023)
Index Volatility (30-Day Historical) | 34.6 100 -
Index Avg. Day High-Low Range 101.70 (Apr 2023)
Correlation with HSI, CES120 (2023)| 0.982,0.929 95 -
Correlation with CSI300, FTSE A50 0.681,0.675
(2023)

920 T T .
3-Apr  10-Apr 17-Apr 24-Apr

HSCEI & Top 5 Constituents

1209 _hscel —— Ping An
Tencent = CCB
Meituan Baba
100 \
80 -
60
Feb-23 Mar-23 Apr-23

Distribution of HSCEI Index Options Ol in Month-end

Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.34Mn (As at 28 Apr 2023) Call
14.2
125 |
] S 108 E
Transaction Cost* S 9-4 i
o . —
Stam p Duty N/A § 8.4
@ 7.4
Trading Fee HK$3.5 / contract T 64
%] E
< 54 E
SFC Levy HK$0.54 / contract g 47 T
= 42 |
Commission Rate Negotiable 2.0 , , , , , .
0 10 20 30 40 50 60
Margin as of 24 Apr 2023 HK$29,550 Open Interest ('000)

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 28 April 2023

X

Put
14.2

~

Si2.5
2108
Soa
g4
= 74
N 6.4
§ 5.4
=47

42

2.0

° ||"||‘

20 40 60
Open Interest ('000)



Weekly HSI & HSCEI Options Performance

Weekly HSI Options

Contract Multiplier

Liquidity Providers

Transaction Cost*
Stamp Duty

Trading Fee

SFC Levy

Commission Rate

Weekly HSI & HSCEI Options Volume

HK$50 Volume

Akuna, Eclipse, I-Access, IMC, Maven,  (No. of Contracts)

Optiver 30,000 - ® Weekly HSI Options
25000 - m Weekly HSCEI Options
20,000 -

N/A 15,000 -

HK$10 / contract 10,000 -

HK$0.54 / contract 5,000

Negotiable 0 -

RO 6"‘,\ N \q/\b& '&\b(\b‘\b( ’<\\v\ %\b&@\b‘ (]9\5( q:\\b(%b‘\v (f?\v (ﬁ)\u q,/\\v {ﬁ)\v

Weekly HSCEI Options Volume

Contract Multiplier

Liquidity Providers

Transaction Cost*
Stamp Duty

(No. of Contracts)
==\ eekly HS| & HSCEI Options Call

HK$50 16,000 -

Akuna, Eclipse, I-Access, IMC, Maven, Weekly HSI & HSCEI Options Put
Op‘“ver 12,000 .

N/A 4,000 -

HK$3.5 / contract o+

Trading Fee
SFC Levy

Commission Rate

Data Source: HKEX

HK$0.54 / contract N\ 6\‘)‘\'\\b‘\‘yr{b\v\b‘\h&\\b‘\‘y@\b‘(ﬁ\vrﬁv@‘\vf@vf@vfi\\vq‘?\v

Negotiable

An investment tool to manage short term event risk

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 28 April 2023
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2023 vs 2022) _— No. of Single Stock Derivatives

Stock Futures
Stock Options

Stock Futures (YoY)

Av erage Daily Volume

Open Interest
(No. of Contracts)

(No. of Contracts)

652,041 (+11%)

Av erage Daily Volume
(No. of Contracts)

29,
9,898,

7,180 (-8%)

Stock Options (YoY)

151 (-14%) Single Stock Futures
995 (+28%) Single Stock Options

Latest and Future Developments

126

Open Interest
(No. of Contracts)

12,000 | mmm—ADV (L-Axis) - 40,000 800,000 ADV (L-Axis) SR Siock Futures
10.000 - Open Interest (R-Axis - 35,000 Open Interest (R-Axis) | 14 500000
’ - 30,000 600,000 - o
8,000 - L 25000 - 8,000,000 ¢ Products
6.000 - L 20000 400,000 - _ 6,000,000 > 3 A-shares ETFs futures contracts
4.000 A L 15,000 4,000,000 > Total 98 stock futures contracts
’ 10,000 200,000 1 2,000,000
2,000 (T8 I [ 5000 000,
o L1 N g AR NRRRNEEE I
N0 NPT PSR |
DN N N R

Stock Futures (MoM)

Av erage Daily Volume
(No. of Contracts)

Open Interest
(No. of Contracts)

_ mmmmm ADV (L-AXxis) _ 800,000 -
10,000 Open Interest (R-AXxis) 50,000
8,000 1 .= 1 n 40,000 600,000
6,000 - - - 30,000
400,000 -
4,000 H - 20,000
2,000 1 10,000 200,000 -
0 . -0 0
—e=a= > 0 o
§33338285882%
2022 2023

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 28 April 2023

X

Stock Options (MoM)

Av erage Daily Volume
(No. of Contracts)

ADV (L-Axis)

Open Interest
(No. of Contracts)

Stock Options

Products
» 3 A-shares ETFs options contracts

open Interest (RAxis) | 2000000 > Total 126 stock options contracts
| \/\/\/— - 8,000,000 * Market Makers (MMs)
» 3 types of market makers (PMM/ CQMM/
QRMM)
- 4,000,000 : . .
» CQMM to provide 50 series continuous
guotations
0
PR ] "n=>0 i
£53335628582¢2
2022 | 2023




Hang Seng TECH Index Futures, Options and Futures Options Performance

Hang Seng TECH Index Open Interest (as of 28 April 2023)

e T Tracks the largest technology companies
e PSS TR S Open Interest
listed in Hong Kong (No. of Contracts)
280,000 -~
Hang Seng TECH Index Futures & Options & Futures Options 240.000 -
Contract Multiplier HK$50 per index point 1
. . 200,000 -
Notional Value (1 Contract) HK$195K (As at 28 April 2023)
No. of Liquidity Providers Options: 5 160,000 -
120,000 -
Transaction Cost* 80.000
Stamp Duty NA §§§8’8888%€E§-
Trading Fee HK$5.00 / contract = " < o z o> u =2
SFC Levy HK$0.54 / contract 2022 | 2023 |

Average Daily Volume (as of April 2023)
A .'

(No. of Contracts)

120,000 -
100,000 -
80,000 -
60,000 -
40,000 ~
20,000 -

0 -

o 5
o <
o

2022 2023

Providing investors with a tool to manage their risk exposure

; . Volume and Open Interest continue to growth
to Hong Kong-listed technology companies

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 28 April 2023
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MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Average Daily Volume (as of April 2023)

. Balanced representation from 11 sectors
Index Description

of top 50 China A shares ADV
(No. of Contracts)
Index Level 2,157.28 (As at 28 April 2023) 20.000 -
Index Volatility (30-Day Historical) | 20.7
15,000
Index Avg. Day High-Low Range 20.15 (April 2023)
10,000
CSI300 Correlation (2022) 0.949
. 5,000
FTSE A50 Correlation (2022) 0.975
0
MSCI China A 50 Connect Index Futures
Contract Multiplier US$25 2022 | 2023 |
Notional Value (1 Contract) US$0.05Mn (As at 28 April 2023) Open Interest (as of 28 April 2023)

Average Quote Size US$0.27Mn (5 Contracts)
Open Interest
(No. of Contracts)

30,000 -
Transaction Cost*
25,000 -
Stamp Duty N/A
. 20,000 -
Trading Fee US$0.5 / contract
SFC Levy US$0.07 / contract 15,000 +
Margin as of 24 Apr 2023 US$2,950 10,000
s 5§ 3 % % 8 3 8|8 8§ =88 &
s » 2 v O z ol 1L = <
2022 | 2023 |
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 28 April 2023



MSCI Asia and Emerging Market Index Futures Performance

Index Description

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*
Stam p Duty

Trading Fee

SFC Levy

Average US$40
Average US$45K (As at 28 April 2023)
12

N/A
US$0.6-US$1.0 / contract
US$0.07 / contract

HKEX with the broadest suite of MSCI derivatives products
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 28 April 2023

Open Interest (As of 28 April 2023)

Open Interest
(No. of Contracts)

100,000 ~
90,000 -
80,000 -
70,000 -
60,000
= 53985 3 8 & %
= v} < [0p) e [m)] ] [N
2022 | 2023
Average Daily Volume (As of April 2023)
ADV
(No. of Contracts)
40,000 -
30,000 -
20,000 -
10,000 -

0_
> = o> 0
< 53 53 & 88 8 8|3
s 5 I 0 Z o~

2022

Volume and Open Interest continue to growth

(5]
LL
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MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2023)

HSCEI Correlation (2023)

MSCI AxJ Futures

representation 2 DM countries (excl. Japan)
and 9 EM countries in Asia

508.62 (As at 28 April 2023)
20.8

5.88 (April 2023)

0.908

0.902

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

US$100

US$51K (As at 28 April 2023)
US$0.25Mn (5 Contracts)

0.8 index points (April 2023)

Flow and 11 banks

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 24 Apr 2023

N/A
US$0.5 / contract
US$0.07 / contract

US$2,000

Futures contracts have relatively lower transaction costs

Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference onlv

As at 28 April 2023

Open Interest (28 April 2023)

Open Interest
(No. of Contracts)

1,200 -
1,000 -
800 -
600 -
400 -
200 -
0 +— — f-
f523§58:8388:¢3
2022 | 2023 |

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

MSCIAXJ e MSCI China MSCI HK
120 - MSCISG o MSClInda MSCI Indonesia
----------------- MSCI Korea e MSCI Malaysia MSCI Pakistan
----------------- MSCI Philippines - MSCI Taiwan MSCI Thailand

80 - T

Feb-2023 Mar-2023 Apr-2023
MSCI AxJ is a well-established benchmark representing Asia

regional (excluding Japan) equity market performance

13



Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2023)

HSCEIl Correlation (2023)

10 largest and most representative
HKEX-listed mainland banks stocks

2,657.30 (As at 28 April 2023)
20.2

26.76 (April 2023)

0.781

0.784

Hang Seng Mainland Banks Index Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 24 Apr 2023

HK$50

HK$0.13Mn (As at 28 April 2023)
HK$0.66Mn (5 Contracts)

N/A

N/A

N/A
HK$2 / contract
HK$0.54 / contract

HK$6,540

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 28 April 2023

5-Min Avg. Bid-Ask Spreads (28 April 2023)

HSMBI Futures

CEB Bank 6818.HK
Minsheng Bank 1988.HK
Bank of China 3988.HK
ABC 1288.HK

CM Bank 3968.HK
Bankcomm 3328.HK
CITIC Bank 998.HK
ICBC 1398.HK

CCB 939.HK

PSBC 1658.HK

0.49%

Index & Constituents 3-Month Performance (Rebased to 100)
=—HSMBI ——CCB (939.HK)

ICBC (1398.HK) BOC (3988.HK)
——ABC (1288.HK)

120 -

Feb-2023

Mar-2023 Apr-2023

HSMBI Futures can be used for hedging

14



CES120 Index Futures Performance

CES120 Index

80 A-Shares and 40 HK-listed Mainland

Index Description ) ) )
China H-shares, P-chips, and red chips

Index Level 5,622.34 (As at 28 April 2023)
Index Volatility (30-Day Historical) | 24.7

Index Avg. Day High-Low Range 59.76 (April 2023)

CSI300 Correlation (2023) 0.857

FTSE A50 Correlation (2023) 0.864

CES120 Index Futures

Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.28Mn (As at 28 April 2023)
Average Quote Size HK$1.41Mn (5 Contracts)
Average Bid-Ask Trading Spread| N/A

Liquidity Providers N/A

Transaction Cost*

Stamp Duty N/A

Trading Fee HK$5 / contract
SFC Levy HK$0.54 / contract
Margin as of 24 Apr 2023 HK$14,070

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 28 April 2023

5-Min Avg. Bid-Ask Spreads (28 April 2023)

CES120 Futures | NA

K Shares A50 ETF (2823140 —

CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

130 eee=CES120 Index Tencent CCB
——Ping An ——— China Mobile

120 -

110 -

100 -

90 ~

80 T T
Feb-2023 Mar-2023 Apr-2023

CES120 Futures can be used to hedge A-share positions

15



Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information  HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI EM Asia |MSCI EM Asia
: MSCI China [MSCI China NTRJex China NTR  |ex Korea NTR MSCI EM EMEA
Information (USD) Index [Connect (USD) (USD) Index |(USD) Index (USD) Index (USD) Index NTR (USD)
Vendor Futures Index Futures Futures Futures Index Futures
Bloomberg HKCA Index  MCYA Index CSIA Index  CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index
Refinitiv 0#HMAN: 0#HMCA: O#HCHI: O#HCHN: 0#HMAC: 0#HMAK: O#HEAN: O#HMEE:
WIND MANF.HK MCAF.HK EANF.HK

MSCI EM ex
Korea NTR
Information (USD) Index
Vendor Futures
Bloomberg HQIA Index HQYA Index
Refinitiv O#HMXK: O#HMEL:
WIND

. MSCI Japan  |[MSCI Japan
Information [NTR (JPY) NTR (USD)
Vendor Index Futures |Index Futures

Bloomberg HQBA Index HJCA Index
Refinitiv 0#HMJJ: 0#HMJU:
WIND MJUF.HK

MSCI
_ Singapore
Information (USD) Index NTR (USD)
Vendor Futures Index Futures
Bloomberg HOBA Index  HKPA Index
Refinitiv O#HMGN: O#HMSN:
WIND

Data Source: HKEX

X

HMPA Index
O#HMEM:

HMOA Index
O#HEMN:

HLCA Index
O#HMHN:

MSCI New
MSCI Malaysia [MSCI Malaysia |Zealand NTR
(USD) Index |NTR (USD) (USD) Index
Futures
HMYA Index  HKEA Index  HOPA Index
0#HMMY: 0#HMMN: O0#HMNZ:
MMNF.HK

MSCI Taiwan
MSCI Taiwan |MSCI Taiwan [25/50 NTR
(USD) Index  [25/50 (USD) (USD) Index
Futures
HJAA Index HRCA Index HRDA Index
O#HMTW: O#HTWP: O#HTWN:
MTWF.HK

MSCI India
NTR (USD)
Index Futures

HJDA Index
O#HMIN:
MINF.HK

HRTA Index
O#HMDA:

MSCI Pacific

ex Japan NTR |[MSCI Pacific
(USD) Index NTR (USD)
Futures Index Futures
HRPA Index HRBA Index
O#HMPJ: O#HMPC:

MSCI Taiwan |MSCI Thailand
NTR (USD) (USD) Index
Index Futures |Futures

HJIBA Index HMTA Index
O#HMWN: O#HMTH:
MWNF.HK

MSCI

Indonesia

Index (USD)

Futures

HMLA Index HKBA Index

O#HMID: O#HMDN:
MDNF.HK

MSCI

Philippines

(USD) Index

Futures Index Futures
HNSA Index HLEA Index
O#HMPH: O#HMPN:

MSCI Thailand |[MSCI Vietnam
NTR (USD) (USD) Index
Index Futures |Futures
HKDA Index HNTA Index
O#HMTN: O#HMVT:
MTNF.HK

MSCI EM ex
China NTR

(USD) Index
Futures

HQDA Index
O#HMXC:

(JPY) Index
Futures

HQAA Index
O#HMJIP:

MSCI
Singapore
Free (SGD)
Index Futures
HKOA Index

0#HMSG:

MSCI Vietham
NTR (USD)
Index Futures

HKSA Index
O#HMVN:
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Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks
Index

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Information Vendor Mainland
Banks Index

East Money HSMBI

Hexin Flush Financial

Pobo Financial

Qianlong 999905

Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
0#HMBI:

Mainland Banks
Index Futures

MBI

MBIC

MBI+Month+Year
209

MBIF+yymm+HK
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. } CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X



